Excel Dressage Scoring Suite

Key Features

· All tests able to be accommodated – loading the test separately.  All EA and FEI tests supplied, and able to accommodate other tests (e.g. Pony Club) without updates to scoring program
· Separate Worksheet for each class – have as many divisions / classes as required for a competition.  Each one is separate, and can be processed by different scorers
· Results printout professionally formatted and suitable for direct posting on scoreboard
· Data entry of scores on screen corresponding directly with printed test – all movement text visible on screen for easy checking of correct corresponding mark entry
· Individual rider’s scores (all movements) can be printed along with test movements – for checking of data entry or for judges to consult regarding marking
· Interactive Checks to help highlight missed or invalid marks being entered
· Entirely Microsoft EXCEL
· Separate File of Horses and Riders reused for different classes and competitions, reducing data entry
· Ability to import Horses and Riders from simple Spreadsheet template – which can be “cut and pasted” from draw information
· Straight Dressage and Freestyle test versions as well as support for Young Horse, including 7YO
· Caters for both Competitive EA dressage (with Horse Registration numbers and Rider membership numbers) and Participation or Restricted days (using internally assigned references)
· Errors (including additional errors) automatically calculated and applied to correct category
· All results calculated to 3 decimal places
· Individual judge percentages and overall result produced
· Freestyle version gives separate Technical and Artistic percentages for each judge
· Caters for any number of judges between 1 and 5 for any classes.  Data entry adapts for the number of judges entered
· Shows individual judges rankings for all participants (including HC entries), and over-all placings
· Places calculated according to all EA and FEI rules (including FEI article 434.3 for individual placings)  Equality of placing correctly handled in all circumstances covered by rules.  Individual judge’s ranks include results of HC competitors, final results do not.
· Interim score sheets allow sorting results with scores available above other rides not yet completed which remain in original draw order
· Up to 50 entries can be handled (49 for Freestyle)
· Extract capability to produce simple small files for transmission for result publication and import into other (e.g. EA) databases
· Ability to apply image logos (club and/or sponsor) to score sheets
· Championship calculator can reference up to 30 individual classes (with up to 150 different combinations), and automatically calculates championship points.  Includes aggregated percentages for splitting equalities if that basis is being used.
· Able to be supplied without charge to the EA for free supply to affiliated clubs.  Copyright restricted to use and distribution by EA and affiliated clubs without charge, and preventing use or further adaptation without permission.
· Ability to include or suppress extended information about horse and rider, including Owner etc
· Allows ½ marks for EA and FEI tests
· Optional entry of decimal point for half marks between 1.5 and 9.5 to speed up data entry.
· Ability to export marks for a judge, and then import into another scoring sheet (or to a different judging position in the same class).  Allows for data entry on different computers, and then consolidation into a single class result – speeding up that last test of the day.
· Caters for FEI Error of course scoring – both Senior and Junior (2nd Error elimination, 1st Error 2% deduction, or 0.5% deduction first error, 2nd Error deduct another 1% then 3rd Error elimination), or EA scoring (1st Error deduct 2 marks, 2nd Error deduct another 4 marks, 3rd Error elimination)
· Highlights tests where Judges total marks differ by a percentage which needs to be discussed by the judges


What is Included

Horse-and-Rider.xlsx

This Excel workbook contains two separate worksheets, “Horses” and “Riders”.  Its function is to be the repository of all Horse and Rider information.  Once entered, data can be re-used for multiple classes and competition without re-keying, dramatically cutting administration, and reducing errors.

Separate “Horses” and “Riders” data reduces the need to duplicate information for riders with multiple horses.

The “Internal Ref” columns (duplicated in the Horse sheet, and not hidden to prevent inadvertent corruption) is the basic reference which can always be used.  The system was developed originally for Queensland competitions, where each registered horse has a permanent Bridle (competition) number.  This number is the simplest and “public” reference for the horse – and is the preferred reference used in the system.  If not available (for non-registered horses), the internal reference can be used.  Where non-permanent bridle numbers are used, a separate Horse-and-Rider.xls database can be used for each competition, with the Bridle numbers cleared out and reassigned between competitions.  Each competition version should be stored in a separate folder along with its associated score sheets.

Horses

The “Internal Ref” columns should not be altered.  As delivered, the reference tables will accommodate 2,000 unique horses and riders.

The ‘Bridle No” column will appear on the main results sheet.  It is also the quickest reference for assigning horses to start lists.  It is an optional field, and does not need to be numeric.

“Horse” should contain the registered name of the Horse.  It is mandatory.

“Registration” should contain the EFA registration number of the horse.  It is optional, and does not appear on the printed view for the scoreboard, although it is copied to the sheet.  The extracted versions for both printing and submission contain this information in a visible column.

“Default Rider” is an optional column.  It should contain an “Internal Ref” for an entry in the “Riders” sheet.  If an entry is present, then this Rider will be automatically assigned for the horse when the horse is entered in a Start List.  This can be over-ridden on a class-by-class basis (if a different rider to normal is riding the horse, e.g. for a Derby type competition).  If the field is left blank, then the rider for the horse will have to be entered in separately every time the horse is added to a competition start list.

“Owner”, “Breeder”, “User Def1” etc.  These are optional fields which may be included on the score sheet.  The Headings of the columns except Owner and Breeder, can be changed (and in the case of the “User Def1” columns, should be), and will reflect on the score sheets.  Any information required can be included, and some of the column headings are only suggestions.

“Horse Cat” can be used for separate placings within a single class (e.g. ponies, or breed placings).  Any value (non-blank) can be used to establish the separate category, but a “Y” makes most sense when viewed within the scoring sheet. Change the “Horse Cat” heading to reflect the actual category name, and it will carry through the score sheet.

Riders

The “Internal Ref” columns should not be altered.  As delivered, the reference tables will accommodate 2,000 unique horses and riders.

The ‘Name” column will appear on the main results sheet, and is mandatory

“EFA No” should contain the EFA membership number for the rider.  It is optional, and does not appear on the printed view for the scoreboard, although it is copied to the sheet.  The extracted versions for both printing and submission contain this information in a visible column

“State / NF” is an optional field, and is optionally included on the Scoring sheets.

“Rider Cat” can be used for separate placings within a single class (e.g. juniors or club members).  Any value (non-blank) can be used to establish the separate category, but a “Y” makes most sense when viewed within the scoring sheet. Change the “Rider Cat” heading to reflect the actual category name, and it will carry through the score sheet.


Automatic loading

Cross referencing Horse and Rider information can be tedious – especially searching to see whether or not a particular horse or rider is already present.  Checking to ensure changes to registration or membership numbers, and catering for typographic errors can be difficult.  To make life easier, an import facility can be used.  To use this, use the Entry Import Template.xls workbook as a template.  This can be saved as any file name desired.  The only mandatory information is either a horse name or a rider name.  Other detail is optional.  The Import Horse & Rider Data button will enable the data to be added to the Horse-and-Rider.xls interactively.  Conflicting information will generate prompts to enable the appropriate action to be taken,
Scoring Master.xlsx
Scoring Freestyle Master.xlsx
Young Horse Master.xlsx
7YO Young Horse Master.xlsx

These workbooks are respectively the scoring systems for straight dressage tests, freestyle (kur) tests and Young Horse dressage and finally the hybrid for 7YO Young horse.  There are distinct differences in the way results are presented, and the rules for placings between Freestyle and regular dressage tests, hence the two different versions.  Young horse tests are totally different in scoring, in that a common scoresheet is used, regardless of the test actually ridden, except for the 7YO, which includes a regular dressage test for the Technical aspect.  The way in which they function, and the entry of data is identical, although there are some minor differences in options available (penalties for exceeding time only apply to freestyle, whereas error of course or test only applies to straight dressage).

There are 3 visible worksheets used for both scoring systems.  (There are also hidden working sheets, but these never need to be referenced).


Score

The final results sheet.  This sheet is printed for the score board, and shows the final scores, ranks and placings.  No individual competitor entry occurs on this sheet.  The interactive versions consist of 4 macro buttons, and a “pick list” toggle.  The Club and Venue information can also be directly edited on this sheet.  It is suggested that these changes are done on the supplied master copy by the club, and this version saved as a new master.

“PROGRESSIVE / FINAL”.  On the top right of the sheet (under the Right Hand logo), appears a toggle selection, which can be set to PROGRESSIVE or FINAL.  This has no interaction with anything else in the scoring system, and only serves to allow for the differentiation between Progressive score sheets for posting on the score board during the competition, and a Final classification for signing.

SORT SCORES button.  The ranks and placings update dynamically as data is entered and finalised, but a macro must be run to change the order on the results sheet.  Clicking this button sorts the competitors into a placed order.  HC combinations are sorted into the order in which they would have appeared if they had not been HC (although no placing is assigned).  Combinations with no score available retain the original order of the draw.  Those combinations eliminated appear at the bottom of the list, ahead for those Retired or Scratched)

EXTRACT RESULTS button.  The workbook for scoring is quite large, and contains dynamic links to the Horse-and-Riders data, as well as all the individual movements entered.  For sending to other parties, only the final scoresheet data is required.  This button runs a macro which copies the relevant data to a new “flat” work-book.  Two options for output format are currently available, one in “Print” format which creates a small Excel workbook without formulae, links or macros, looking visually similar to the scoresheet.  The other output format is a data entry format for loading by Equestrian Australia into the National Results database.  When run, the macro will create a new Workbook, and save it with a generated name (in the same folder as the original scoresheet).

REPLACE LEFT/RIGHT LOGO buttons.  There are two graphic images included to customise the scoresheet.  To simplify insertion (as the sheet is protected), and to assist with correct positioning and sizing, these buttons are supplied.  They will delete any current image in the corresponding position, and open a file browse/selection window to allow a picture to be selected for insertion.  Once selected, it will be appropriately scaled and positioned.  If you wish to simply delete one of the images, selected the button, and hit the “CANCEL” option on the file browse window.


Start List

The sheet configures details of the class, including the starters and Judges.  Information entered here controls the functions of the other sheets.

All information on this sheet must be entered and finalised before scoring commences, otherwise results entered may be deleted or incorrectly assigned.

Class Information.  The top left contains 6 cells of information used to describe the class.

The “CLASS” field contains the class name – and will reflect on the printed SCORE sheet.  This can be typed with whatever is desired.  Typical entries may include “Novice 2.3”, “Prelim 1.4 Division 4” or “SPONSORS NAME MEMORIAL GRAND PRIX”

The “DATE” field is self explanatory, and must be entered – otherwise the SCORE sheet printed for results will display “0 January 1900”.  For Official classes where the results will be submitted to the EFA, this must be a single date in a recognisable date format.

The “TYPE” toggle box reflects on the main score sheet.  It is included (and must be selected) to enable easy distinction between different categories of competition, and is especially relevant when classes are named solely by the test, and are run on the same date by the same club for both categories of competitor.

The “GRADE” field is protected, and is required for Competitive classes where the results are submitted to the EA.  It is automatically populated when an EA test is imported.

The “EA CLASS” field is required for Competitive classes where the results are submitted to EA.  It is automatically populated when an EA test is imported, but can be chosen from the Pick List as well.

The “DIVISION” field is used for Competitive classes where the results are submitted to EA and more than one competition is run for the same “CLASS”.  It must be picked from the values in the list.

The “ERROR RULES to APPLY” field is required and automatically populated from supplied tests.  It can be changed if necessary.  It determines which of EA error rules, FEI Senior or Junior will apply to errors of course.

The “Hi/Lo DROP SCORING” filed should always be left as “N”.  The system will apply the proposed Hi/Lo drop to the final mark if this is selected, but it can only be selected when 5 Judges are officiating. 


Judges.  There is provision for the names of up to 5 Judges.

Correct entry of information in these fields is vital, as it controls the behaviour of the data entry sheets.  Typically, the information cannot be completed by scorers until the first sheets are returned, as in most cases there is not certainty of which positions each judge will be in until they have started judging.  As supplied, the master has default names in each position.  Those judging positions which are vacant should have the contents of the cell deleted, and the correct name should be over-typed in the other positions.  Although there is no validation, there must always be an entry in the Judge’s position for “C”.

Entry of name data in these fields is reflected on the printed score sheet, controls whether or not column headings are present for that position on the scoresheet, and interacts with the configuration macros on the data entry sheet to allow entry of results.

Start List Information  There are 4 columns in which entry can be made for each horse and rider combination.  If all information is entered in the Horse-and-Rider workbook, most entrants will only require a single cell to be entered.

Information is entered from the top down, in draw order.  As each row is populated, the “Start No” field appears.  This is an internal reference which is used to populate data between sheets, and should not be touched. Under no circumstances should you delete any rows in this area.  Doing so will cause corruption in the results and #n/a or #ref errors.

HC – this column contains a drop-down pick list, allowing entry of “HC” for non-competitive entries.  This should be selected where appropriate, and otherwise left blank.  This is the only place to assign an entry to HC, and controls inclusion in final placings.

Bridle No. -  This is the simplest, fastest and preferred method of entering a combination.  Where permanent bridle numbers are assigned, it provides rapid entry, and minimum ongoing data update between competitions.  If a match is found, then other data will be automatically populated.  Where duplicates exist (or no Bridle number is assigned), the first match in the list will be returned.  It is these cases, where the next column comes into play.

Override Ref – Where no unique bridle number reference is found, the horse can be inserted by typing the Internal Reference number from the “Horses” sheet into this column.

Override Rider – Where a default rider is found for the horse, the rider details are automatically populated.  This may not be the correct information, either because the link has not been made in the “Horses” sheet, or because a different rider will be riding in this class.  In this case, entering the Internal Reference for a Rider (from the “Riders” sheet), will populate that rider for the horse for this score sheet.

From Column “L” across to the right, are configuration options for extended data.

“Show Rider State” when set to “Y” will cause any values for riders to appear in brackets after the riders name on the Score Sheet.  Across from this, after the word EXCEPT FOR, appears a Pick List.  If a value is selected, any Rider with a “State/NF” field matching this value will NOT have the state appear.  This is useful where riders are mainly local, and a value is only required on an exception basis.

“Use Extended Horse Data” when set to Y adds a second line under the horse’s name on the scoresheet, with extended data.  If this option is selected, changes to the “Start List” do not immediately populate on the score sheet – the “Refresh Score Sheet” button must be used to run the macro to do this.  This restriction is imposed due to the way formatting is handled within Excel.

“Separator for Horse Data” allows a pick list selection of symbols to use to separate the different fields chosen for the extended Horse data.

“Use on Score Sheet” options.  For Owner and Breeder, a “Y” or “N” choice selects whether this information should appear.  It will appear under the Rider on the Score sheet, with Owner before Breeder (if both are selected).  For the other Columns, the order in which they appear can be selected.  To leave a column out, leave the “Use on Score Sheet” option above the column blank.  Columns with a number selected will appear in ascending numerical sequence.

“Extended Horse Data Font Size” can be used to make the extra information about the Horses larger or smaller. If many fields are selected, with a lot of information, a smaller font will have to be selected to fit it all in.

Columns “BM” and “BN” provide options for additional placing categories – 1 based on rider eligibility, and one on horse.  The use of “I” will Include any horse/rider in that category in the main placings, as well as the extra category placing (useful for additional member places, or breed places).  Using “O” will omit the placing from the main class, and only place the combination within the category (useful for including ponies and horse on the one sheet, but placing them as 2 separate classes). The headings for these categories are obtained from the column headings in the Horse-and-Rider.xlsx worksheets.  To change the headings here (and on the score sheet), the category heading should be changed in the Horse-and-Rider.xls workbook.  The “Refresh Score Sheet” button can be used after these options are changed to hide or reveal the placing columns on the score sheet as appropriate.

Scores

The main data entry sheet used to perform scoring on the day.

There are two important macro buttons on this sheet, which should only be used prior to entering score data.


IMPORT TEST button.  The left most button imports the correct dressage test.  This brings in the correct movements (text), as well as the appropriate coefficients and collectives.  Artistic and Technical aspects of Freestyle tests are established in this function. (This function is not applicable to Young Horse classes, as the scoresheet is always the same).

When the button is activated, the current test and all entered scores are deleted.  A file browse window will open, and the appropriate .xls version of the test should be selected.  If the file does not contain an appropriate test (freestyle for the freestyle master, normal for regular dressage, or not even a correctly formatted test), the results will be unpredictable.  Macro errors may well result.  The only certainty is that things will not work!

After selecting the test, it will be opened and copied in.  During this, a warning box will appear about large amounts of data placed on the clipboard.  “No” can be selected to close this box. Do not select “Cancel”, or the import will fail.  If you should do so by mistake, select “End” on the resulting Error box, and start the Import again.

UPDATE FOR JUDGES button.  The right button adjusts the number of columns for each competitor for the appropriate number and position of judges.  The Judges’ names entered in the “Start List” sheet control which columns are made visible.  This update should be performed after the judging positions are confirmed (and the Judges’ names entered appropriately), and before entering any marks.  Again, this function is not applicable for Young Horse scoring, as the judges confer and agree a single mark.  The names of the judges are present for information on the score sheet only.

Normally, all data entry into the Start List (except Judge’s final names / positions) will be done prior to the competition day, as will the importing of the test.  When the first test sheet is returned, Judges’ positions are confirmed and updated, then the UPDATE FOR JUDGES is performed before entering the first scores.

Score Entry.  The scores for every movement from each Judge for each horse are entered.  The Bridle Number and Name of the Horse appear above the Column for the scores for the Judge at C at the top of the sheet.

Immediately below the Horse’s name, are the Master control entry functions for the combination.

The “Status” row is used to indicate the status of processing for this combination.  It starts off with a ‘-‘ by default – indicating entry has not taken place.  When this value is present, scores are not calculated.  The result on the Score list will be blank, and will remain sorted in the original draw order, below those combinations for which scores are available, but above those finalised without a valid score (scratched, retired, eliminated, did not show).

To calculate a score, and activate the warnings for incomplete data entry, the ‘-‘ should be deleted.  This can be done either by using the ‘Delete’ button on the keyboard, or selecting the blank option from the Pick List in this cell.  Other options available are “SCR” (Scratched), “DNS” (Did not Show – if handled differently to scratched) “Ret” (Retired) and “Elim” (Eliminated).  Eliminated should not be selected where excessive errors are to result in elimination, as this will be automatically applied from the entry of the number of errors.  Reasons such as leaving the arena, incorrect equipment etc would lead to the direct use of “Elim”.

The “Errors” row (not applicable to Freestyles) is used to indicate the number of errors noted for the test.  This is the number of errors, not the penalties, as the penalty (including elimination) is automatically calculated.  No error is indicated by leaving the cell blank.  1, 2 or 3 errors can be entered by either typing the number directly, or selecting from the Pick List.  To remove errors incorrectly indicated, either use the “Delete” key, or select the blank option from the Pick List.



The “Test Length” row (only applicable to Freestyles) is used to invoke the penalty for exceeding the time allowed.  Select “Yes” from the Pick List (or type “Yes” exactly as it appears, including case sensitivity) if the penalty is to be imposed, otherwise leave the cell blank. To remove a penalty incorrectly indicated, either use the “Delete” key, or select the blank option from the Pick List.

The “Other Technical Errors” or “Other Error” row is used to invoke the penalty for carrying a whip into the area immediately surrounding the arena (for incorrectly carrying a whip which is not permitted, select “Elim” in the “Status” row), for exceeding the entry time limit, entering before the bell, or other technical errors which are not Error of Course or Error of Test.  Select the number of such errors to be imposed from the list, or type the number, otherwise leave the cell blank. To remove a penalty incorrectly indicated, either use the “Delete” key, or select the blank option from the Pick List.

[bookmark: _GoBack]Marks for Movements  Are entered vertically, under the column Headed with the appropriate Judge’s position.  The values able to be entered are validated, but there are no drop down boxes.

The fastest way to enter results is to use the numeric keypad to enter the digits, and use either the down arrow key, or “Enter” to move down each cell.  The movement number and text will remain visible on the left hand side of the screen and scroll down with entry.  This enables confirmation that the correct mark is being entered for each movement regardless of where in the test, or for which rider, data entry is being performed. When entering scores containing half marks, the use of the decimal point is optional for those values which can be unambiguously interpreted.  A mark of “5.5” may be entered with the decimal point, or as “55”.  The only score which will always require a decimal point to be entered is a mark of “0.5”.

If an incorrect number is entered, then an Error Box will pop up.  Selecting “Retry” will enable the number to be overtyped, Cancel will delete entry.  Note that once “Retry” is selected, you must hit “Enter” after inputting the correct figure, as the down arrow key will not work.  The most common reason for error is failing to move between cells between entry of marks (due to speed, or not quite hitting the down arrow key), leaving consecutive digits entered in the one cell (i.e. instead of entering scores of 7 and 8 for consecutive movements, 78 appears for the first movement!).  The validation will prevent this happening, and avoids having to re-key large numbers of scores which have been inadvertently entered against the wrong movements.

When the “Status” is set to blank, the scores entered will be totalled for marks, and converted to percentages (obviously applying coefficients, and working differently for freestyle).  If there are score entries missing, then the calculated totals will be highlighted in light Yellow to warn of possible incomplete entry.  The highlighting is not totally foolproof, as it may also occur for tests where a mark of “zero” has been awarded for a movement.

The Test% for two or more individual judges for each competitor may be highlighted in orange. This indicates that the different in percentage between the highlighted judges marks exceeds the threshold at which the judges need to discuss the test. Please ensure that these test sheets are available to the judges for that discussion, by drawing them to the attention of the judges, and photocopying the actual sheets if necessary.

Printing a Combination’s marks.  In order to allow checking of data entry off-line, or for Judge’s to confer and consider marking issues, the facility is provided to print the entered scores for a single combination.  Simply select any Cell in any of the columns for the horse required (any mark entry, or any of the Status rows) and then hit Ctrl-P (Hold down the “Ctrl” key and press “P” whilst holding it).  This will invoke a macro which will set the print area to the correct positions for all marks for that horse, size to a single page, and print the sheet.

Championships Master.xlsx

At the very end of a major competition over multiple days, the final Champions need to be confirmed, and the scorers are typically under pressure to accurately work out information in a hurry.

The Championship calculations will quickly and simply “score” a Championship according to the basic criteria of EFA Rule 3.18.  It will add percentages, and sort based on the aggregation of percentages, but does  not split equalities of points. The decision of method of splitting equalities is determined by the organising committee (aggregation of percentages, consideration of “highest test”, some other criteria), but this can be manually performed in the event of equality. The raw data is available, and the results are sorted “splitting” on aggregated percentage, should this approach be utilised.

This tool does not produce “display” quality output, and is intended for the internal use of the competition organisers.

This Workbook requires Macros to be enabled, and needs an absolute minimum of data entry.

This Excel workbook contains multiple worksheets, only 2 of which need to be selected for use.

Summary  Is where the results appear.  The only 2 cells requiring or able to be updated are the top left – where the Club or other name, and the Championship type can be entered. 

The “SORT” button will sort the results in point order, with the highest appearing at the top.

Reference is where classes will be added.  There is only 1 selectable cell on this worksheet 
(labelled next to “First Place Points”).  EFA Rule 3.18 suggests the allocation of 30 points for 1st place, descending from there.  This suggestion has remained from the time when the number of starters in a class was limited to 30.  The number of starters permitted is now 35, meaning that the suggested mechanism will not distinguish between placegetters 31 to 35.  Either 30 (strictly according to the rules) or 35 can be selected for the First Place Points.  In almost all cases, there is no difference in the results obtained from either approach.

To add a Class to the Championship, use the “Add Class” button.  A file browse window will open, and you should then select the Workbook for the scores for the class.  Straight Dressage and Freestyle scoresheets can be selected.  The processing will add a worksheet to the Championship to link the scoresheet – and establish links to the scores.  

It is not possible to remove a class added in error without potentially corrupting the workbook.  If this occurs, the Championship should be established again from a new template.

Once linked (and provided the “Update Links” option is selected when the workbook is opened), the results of the classes will automatically update in the Championship page.

When a class is added, each unique combination of horse and rider is added to the Summary sheet for totalling points.  It is important to ensure that the starters are loaded into the individual class scoresheets before adding the scoresheet to the championship.  Any riders added to the class later may not be picked up.  The combinations are added only once – and it does not matter which class they were originally in. If a combination is moved between classes (e.g. switched from Division A to Division B), this will not cause a problem.

How To Use this System

This section contains an overview of how to use the system from a practical stand point.  Some screen examples are provided, along with hints and suggestions.

Before the Day

As each class is stored in a separate spreadsheet, the simplest way to organise things is to keep a separate folder for each event run.  That way the files can be named for the classes (e.g. Novice 2-2 Div A), and be easily identified (if stored the “May 2007 Official” folder.  

The Horse-and-Rider.xlsx may be carried over from competition to competition.  You can choose to either keep this in a central location, or copy to the particular folder.  Depending on where you move this, you may need to re-link to the scoresheets themselves (instructions further down).

There is typically a lot of information common to all classes (date, venue, logos etc).  Creating a single master with this information, then using “Save As” for each class will save a lot of time.

The following steps allow manual entry of Horse and Rider information.  The procedure for automatic loading are described subsequently. Automatic loading is far easier (especially if the draw is available electronically), and is the recommended method.

Step 1

Enter all the riders into the “Riders” sheet in Horse-and-Rider.xlsx   Each Rider should be entered only once.  If you are comfortable with Protecting and Un-Protecting sheets, the following is useful (if it doesn’t make sense, don’t worry, you can still work around this, and you won’t risk corrupting things).

In doing the following, it is strongly suggested that after printing, the Workbook is closed without saving to ensure no changes are made.

Unprotect the Sheet.
Select the entire Sheet.
Select “Sort” on the “Data” menu
Select “Name”, and Ascending order (ensuring that “My data has a header is checked).
Scroll to the last named Rider.
Select the columns with information (A to C), and all the Riders, including the heading.
Select “Set Print Area” on the “File” menu
Print the results
Close the Workbook without saving to throw away the changes.

You now have an alphabetic list of the Riders already present that you can look up to avoid re-entering riders you already have.  This list is also very useful when entering Horses into classes if you need to over-ride any default riders.  The same approach is also applicable to entering and dealing with the “Horses” sheet.

Only enter information in the un-protected cells.  The “Internal Ref” column must not be touched.

Step 2

Enter all the horses into the “Horses” sheet in Horse-and-Rider.xlsx   Each Horse should be entered only once.  If you are comfortable with Protecting and Un-Protecting sheets, the following is useful (if it doesn’t make sense, don’t worry, you can still work around this, and you won’t risk corrupting things).

In doing the following, it is strongly suggested that after printing, the Workbook is closed without saving to ensure no changes are made.

Unprotect the Sheet.
Select the entire Sheet.
Select “Sort” on the “Data” menu
Select “Horse”, and Ascending order (ensuring that “My data has a header is checked).
Scroll to the last named horse.
Select the columns with information (A to F), and all the horses, including the heading.
Select “Set Print Area” on the “File” menu
Print the results
Close the Workbook without saving to throw away the changes.

You now have an alphabetic list of the Horses already present that you can look up to avoid re-entering Horses you already have.  This list is also very useful when entering Horses into classes.  The same approach is also applicable to entering and dealing with the “Riders” sheet.

Only enter information in the un-protected cells.  The “Internal Ref” columns must not be touched.

Entering a Default Rider speeds entry for classes.  If the Rider’s are not entered, you can come back later.

Automatically importing Horse and Rider Information

Instead of manually keying in each Horse and Rider name, you can automatically add new horses or riders (and update / change information on current ones), using the “Import Horse and Rider Data” button (available on both the Horses and Riders worksheets).

Information must be manually keyed into a single worksheet in a separate Workbook – in the format of “Entry Import Template.xlsx” workbook supplied.  This simple entry sheet can be “cut and pasted” to include information from any source.  Duplicated information is not a problem, as only new horses or riders are added.  If soft copies of a draw are supplied to the scorers, copying all the entries can be done quickly, and the system will handle adding the unique entries.

A substantial advantage of this method of data entry is that it searches for potentially matching information, and prompts for the action to be taken (update the existing information or create new entries).  

Step 3

Save “Horses-and-Riders” and close it. You can leave the “Horses-and-Riders” open, which may speed up the updating of links, but may also slow down your PC.

Step 4

Copy the appropriate Scoring Master (and Scoring Freestyle Master) to the folder to be used.

Step 5

Open the Scoring Master.


You will receive a warning about the content. And links, unless you have already established the location as “trusted”
[image: ]

Click on “Enable Content”















To prevent this question being asked every time you open a score sheet, you can add the location to the “Trusted Locations”. This is done in the Trust Centre, which is found in the Excel Options.
[image: ]



Use the File Button (very Top Left), and then select “ Options” (on the bottom of the box)












[image: ]
When the “Excel Options” box appears, select “Trust Center”

















And when the screen changes, select “Trust Center Settings”
[image: ]
















Once you have the Trust Center settings open, select “Trusted Locations:” and add the location of your scoring files to the list.  You must also ensure that “Macro Settings” either allows all macros (not recommended) or is set to “Disable all macros with notification” to allow the user to enable the macros.

In “External Content”,workbook links must be set to either “Enable Automatic Update” (not recommended), or “Prompt User on Automatic update for Workbook links”

If you have moved the Scoring Master, or “Horse-and-Rider” information, you may be presented with a warning that the linked file could not be found.  This will look something like the following:

[image: ]

Whilst you do need to Edit the links, at this stage, you must select “Continue” as the protection in place will not allow updating without additional steps being performed first.


Updating the Links

To update the Links, you must perform the following process.

Step A Select the “Start List” tab
Step B Remove the protection from the Worksheet. Select the “Review” menu from the ribbon bar, and then the “Unprotect Sheet” button. 

[image: ]




Step C Edit the links to locate the “Horse-and-Rider.xls”.  Use the “Data” menu form the ribbon bar, and then select the “Edit Links” option from within the “Connections” group. 

[image: ]

On the pop-up edit box (below) select “Change Source”

[image: ]


A file Browse dialogue will Open.  Navigate and select the appropriate version of “Horse-and-Rider.xls”.  There will be a delay while the links are updated, and then the Update Links box should change to show the Link Status as “OK” as per the following.  Select “Close” to shut the Edit Links box.

[image: ]
[image: ]

You must now restore the protection before saving the sheet.  Select the “Review” menu from the ribbon bar, and then the “Protect Sheet” button. 

Don’t change any of the tick boxes, but Simply click “OK”.  This will prevent accidental over-typing of important cells which must not be changed.

Once the Sheet is protected, SAVE the updated master.






Step 6

On the “Score” sheet, update Club Name, Location and any Logos which will be applicable to all classes.

On the “Start List” sheet, update the “Date”.

[bookmark: OLE_LINK1][bookmark: OLE_LINK2]Save the Master.  


Step 7

Establish Files for each Class to be scored.  Repeat this step for each class necessary

Step A

Open the appropriate Master.

Step B

Select “Save As” from the “File” menu, and save a copy named appropriately for the class.  Doing this now will prevent accidental saving over the top of another class or the master.

Step C

Select the “Start List” tab, and update the data for this Class.   In the “Class” box, enter the name of the Class, change the Date if necessary, and select either “Competitive”, “Participation” or “Restricted” from the Drop Down.
If there are going to be multiple divisions for an Official competition, select a Division.

Step D

Enter combinations into the Start List.  Enter horses in Draw order.  Bridle Number is the easiest method, but Override Ref may be necessary.  Select “HC” where appropriate, and over-ride or enter any Rider references.  You will see the Horse and Rider names populate as you enter data, enabling confirmation of correct entry.

Step E (optional)

If you know the Judge’s names and positions at this stage, you can enter them on the top of the sheet.  Delete any vacant positions (the Master supplied has dummy names in each of the 5 Judging positions so that all columns and fields appear initially).

Step F

Select the “Scores” sheet and Import the appropriate Test (not applicable for Young Horse).  Select from the supplied tests.  Any Dressage test can be imported, as long as the Excel file structure matches that supplied.  Note that normal Dressage Tests and Freestyle tests are different, as the Freestyle Tests have a column (which you never see) which determines which components contribute to Technical or Artistic marks.  Note also that the Movement numbers in regular Dressage tests are important, as the absence of a number indicates a Collective mark – and this can be important for the separation of tied placings.

Step G

Save the class worksheet in preparation for Scoring.


On the Day

As each class is stored in a separate spreadsheet, it is possible to have as many or as few classes as necessary (or as the memory on your computer supports) open at the one time.  You may also have different people and computers handling different classes. 

If you do not need to update Horse or Rider information, there is no need to copy the Horse-and-Rider.xlsx to different machines – simply select “Don’t Update” on the Links warning to retain the data originally entered.

Step 1

When the first Test sheet becomes available, confirm the Judges’ names and Positions.  Go to the “Start List” sheet, and ensure that the Judges’ names are entered against the correct position.

Step 2

Before entering any data, go the “Scores” sheet, and hit the “Update for Judges” button to ensure columns are present for the correct Judges.

Step 3

Enter scores.  Locate the correct Horse by scrolling across.  Enter any Errors, Eliminations etc, and input the marks for each movement.  You can change the status to blank to enable the score to calculate either before you enter any marks, or afterwards.  As soon as you change this, the score will appear in the final list, but not before.  If there is a query (for instance a missing mark for one judge), all other information can be entered, and the status left at ‘-‘.  This will allow an interim score sheet to be printed without the incomplete information (no score available for this horse), and without losing the data entered so far.

Step 4

Save frequently as you go (and this can be added as a Step all through the process)

Step 5

Produce an Interim Results sheet for posting.  Select the “Score” sheet.

Step 6

Sort the Scores into presentation order.  Select the “Sort Scores” button.

Step 7

Check that the score status (under the right hand logo at the top of the Page) is correctly set to PROGRESSIVE or FINAL using the Drop down selection.  Remember that a FINAL sheet should only be posted once signed by the appropriate Judge or Technical Delegate.

Step 8

Save paper and time by setting the print area to match what you need to print.  If you are unfamiliar with this, consult the Excel Help, or simply print the number of pages you need. If you are not using the additional placing categories, change the print area to exclude those columns from printing.  This can also be done by using the “Refresh Score Sheet” button on the “Start List” sheet.

Note

The Young Horse score sheet is set up to accommodate 2 rounds – for State Championships and the like.  For Qualifiers with only one round, simply use the First Round scores.




Finishing Up

Once the final results are done, you will have printed sheets for all the judges, and saved the results.

For sending out, or submission to EA, the internal workings are not required (and the spreadsheets are very large!).

Select the “Score” sheet, and use the “Extract Results” button.  Ensure that you have saved your workbook before running this.  The flattened results sheet is automatically saved with a new name. 

For submission to EA, the specifically formatted (and named) extract should be used.  Data required for submission is sourced from the scoresheets, but the validations for EA may be different.  Errors may be highlighted, which should be corrected in the original source data, and then the extract performed again.  The most likely expected errors would be incorrect Membership or Registration numbers.

Helpful Hints and Suggestions

I have the wrong horse and rider showing on the Score sheet, but I am sure I entered the correct number on the Start List

The most likely reason for this is that there are multiple horses in the Horse-and-Rider database with the same Bridle Number.  When the horse is picked by Bridle number, if there is more than one horse with that number, you may end up with the wrong one.

There are a few different options to address this – depending on the reason.

There may be a typo in entering the Bridle number – either on the Start List or in the Horse-and-Rider database.  Find the incorrect number and correct.

If “permanent” Bridle numbers are in use, has the number been changed from one horse to another?  If this may be the case, find the “old” (retired, sold interstate etc), horse in the Horse-and-Rider database, and delete the Bridle number.  Provided you “Update Links” when opening the score sheet, the correct horse should now be picked up.

If “temporary” numbers are used, you will need to use a new Horse-and-Rider database for each competition.  Check that the correct file is linked to your Score workbook. (see the previous procedure on “Updating Links”.

If a number is being temporarily shared, then the Bridle number will not be able to be used to find the correct horse from the Start List.  Use the “Override Ref” column on the Start List and insert the Internal Reference number (form the “Horses” sheet in the Horse-and-Rider workbook) to select the correct horse.


I have entered a bridle number in the Start List, and it is definitely in the Horse-and-Rider database, but all I am getting is #N/A errors

Make sure that the bridle “number” in the database and the Start List are both numbers (or both text).  A number entered as text (which can happen if it has been cut and pasted from somewhere else), will not match to an actual number.  Try typing your bridle number into the start list with a single apostrophe (‘) in front of the number – which will force the number to be treated as text.  Alternatively, if you have pasted the bridle number as text, try typing the number directly using only the numeric keys.


We are running a Derby type competition, and the same horse is being ridden by different Riders

When a horse is selected on the “Start List”, any “Default Rider” associated with that horse is automatically populated.  If a different rider is required, simply use the “Override Rider” column and insert the “Internal Ref” for the rider from the “Riders” worksheet in the Horse-and-Rider workbook.


We have received late advice that the rider for an entered horse has been changed

When a horse is selected on the “Start List”, any “Default Rider” associated with that horse is automatically populated.  If a different rider is required, simply use the “Override Rider” column and insert the “Internal Ref” for the rider from the “Riders” worksheet in the Horse-and-Rider workbook.  If the Rider is not already present, they may have to be entered into the Horse-and-Rider workbook.


A rider has approached the Organising Committee half way through the day to advise that their horse was entered “HC” but this has not been reflected on the Scoreboard

“HC” entries must be advised in writing prior to the start of the competition.  If the Organising committee determines that this was the case, and the draw and/or scorers have not been correctly advised, the status of the Horse can be changed on the “Start List”.  Simply select the “HC” drop down for the relevant horse.  All scores and places will be immediately recalculated, and the status will appear in the results on the “Score” worksheet.


The organising committee has advised that a rider has had their ride time changed – and this has moved them from one division to another – and we have already entered scores!

Riders can be removed from the Start List (and thus the score sheet), and added to another division.  Don’t attempt to delete rows from the Start List – you will corrupt the whole score sheet.  Go to the rider that needs to be removed, and delete the Bridle Number (or Override Ref if this was used).  Removing this will blank the details, and leave a blank line in the Score results sheet.  Simply “Sort Scores”, and this line will drop to the bottom (where all the other blank lines are).  In the same way, add the rider to the last line of the class they will ride in.  They will appear at the bottom of the list until such time as a score and place is assigned, but as a last minute change, they would not appear in any program or other published list, so the bottom of the score sheet should be fine.


Two riders have the same score, but the System is not showing them as equal, one is placed above the other.  (Also applies to Judge’s individual rankings)

For normal Dressage tests, FEI article 434.3 for individual placings, and the EA rules, have provisions relating to separating the placing for the first 3 positions only. (Freestyle tests have totally different rules for EA competitions, but follow this rule for FEI competitions).  Where the final percentage is the same, the collective marks are compared, and the competitor with the higher collectives places higher.  If the collectives are the same, the placings remain equal. This only applies for the first 3 placings, all lower placings remain equal.  This has a number of peculiar consequences when creating interim placing sheets.  Early in the day, two riders with the same percentage may be separated on collectives, and be ranked 2nd and 3rd.  As more higher scores are entered, and they drop down the placings, they may end up =5th, as the collectives will no longer be used to separate them.  The same procedure is used to separate the individual Judge’s rankings (for the top 3), but as these rankings include HC entries, the “first 3 places” applies across all tests judged. If you are scoring at the World Championships, Olympic Games or a CDIO, then the rules are slightly different, with a further split in the first 3 places in the event of equality, with the collective marks of the Judge at C then being determinative (and this system will not automatically cope with that!)


I am halfway through a class, and I have only just realised I have the Judge in the wrong position

The “Update for Judges” button only hides or reveals columns for the Judges not left blank on the “Start List” – it does not clear scores entered (only the “Import Test” does this).  Scores are only calculated using results for Judges who do not have a blank name.

There is a provision to export all marks finalised for any particular judge.  Hold the “Control” key and press “e” (CTRL-e).  This will run a macro which will export the marks entered for any judge.  Select the Judging position for the judge to be moved (this is the incorrect position you have used to enter scores).  A text file will be created with the same name as the class score file, but with the Judge’s name added to the end.

Once you have exported the marks entered so far, you need to move the Judge. Enter the Judges name into the correct position and delete it from the incorrect position. Use the “Update for Judges” button.  This will reveal the columns for the score in the new position.  You can now import the marks that were previously saved. Hold the “Control” key and press “i” (CTRL-i).  This will present a dialog box to enable you to select the file created previously.



We have started scoring the same class on two different PCs, or we need to catch up, and want to have two or more people enter scores for the same class.

As long as the horse names and bridle numbers are identical (and they should be if copies of the same Horse-and-Rider database are used), then scores entered in one workbook can be exported and imported into another workbook. The Judge’s name must also be identical in both score sheets.

The export and import works one Judge at a time, and only exports marks for combinations which have a status that is not the default “-“.

Using one of the score sheets that has some of the marks entered, hold the “Control” key and press “e” (CTRL-e).  This will run a macro which will export the marks entered for any judge.  Select the Judging position for each Judge that marks have been entered for on this score sheet.  A text file will be created with the same name as the class score file, but with the Judge’s name added to the end. You may end up with several files.

Once you have exported the marks entered in one score sheet, copy the files to the other computer, and open the score sheet that you need to update with the copied marks. Hold the “Control” key and press “i” (CTRL-i).  This will present a dialog box to enable you to select the file created previously.  Repeat for each Judge that had marks entered in the other score sheet.


We have completed the scoring, and have just discovered that one of the 2 Judges was not eligible to Judge the class – we need to re-score for only 1 Judge.

This is incredibly easy – only scores for positions where the Judge’s name is not blank are included.  Simply go to the “Start List”, and delete the name of the Judge whose scores are not to be considered.  Return to the Score sheet for the results, re-sort (if necessary), and everything is done.

A shadow Judge is being mentored, and would like to compare scores and results.

It is not likely that there will be time to process sheets not needed for the competition, but a copy of the scoring Workbook can be provided to the Shadow or Mentor Judge if there is a space PC available.  Adding the Shadow Judge’s name in a position, and using “Update for Judges”, will make a column available for the scores to be entered and totalled.  Whilst the final rider score will now include the Shadow Judge (not correct), the individual Judges’ totals and rankings will not be affected – and totals and ranks for the Shadow Judge can be compared.  The individual Rider result print can be used to print summaries of all the Judges’ scores for any rider of interest.

If the scorers have time on their hands, and are feeling generous, the Shadow Judge’s marks can be entered at the same time as the live scores.  To make the column available, enter the Shadow Judge’s name on the “Start List” and “Update for Judges”.  Once the column is available for data entry, return to the “Start List” and delete the Shadow Judge’s name.  This will allow entry of the marks, but will not total them, or include them in the calculation of results (or print them on the results sheet).  After the class is finalised (or at any time wanted), the Shadow Judge’s name can be re-inserted on the “Start List”, and all the entered marks will be totalled, and the results will appear in the Score sheet on the results list.  The name of the Shadow Judge can be deleted and re-inserted as often as necessary, and whenever the scores for that Judge need to be revealed or hidden.

If there are already 5 judges, or the shadow judge is doing their own data entry, the marks for the mentor judge can be exported from the main score sheet, and then imported into a different score sheet which does not contain the other judges.  These marks can also be imported into a different system used to compare results for Judge’s examinations.  To export the mentor Judge’s marks hold the “Control” key and press “e” (CTRL-e).  This will run a macro which will export the marks entered for any judge.  Select the Judging position for the mentor judge.  A text file will be created with the same name as the class score file, but with the Judge’s name added to the end.  Any score sheet to which the exported marks are imported must have the horse’s names and bridle numbers exactly the same as in the original score sheet, or the marks will not be able to be imported.


A “zero” mark doesn’t seem to be working properly.

It is not often that 0 is awarded for a movement, but it does happen.  When adding up cells, a blank cell looks like a zero to Excel.  When any cell is blank or has a zero value, the totals are highlighted in Yellow to warn of this fact.  It is more frequent that a zero value has resulted from keying errors when typing quickly leading to a cell being missed, than an actual zero being awarded.  Everything still adds up and totals correctly even with the highlighting.  If you have checked, and there are no blank scores, and the zero was awarded and correctly entered, just ignore the highlighting – all the totals, percentages and placings will be correct. 


I can’t run the macros.

Excel 2007 and later utilises the “Trust Center” for security settings.  Depending on how your options are configured, you may not even get a warning about macros.  There are a couple of ways around this.

To change the security settings to get the warning message, you will need to change your Security Settings for macros.  Clicking the Microsoft logo button (top right corner), will open a drop down, which has on the bottom right, an “Excel Options” button.

Once you have opened this, you will have a series of options – you need “Trust Center”

To change the settings so that the warning appears, and you can enable macros for each Workbook, select the “Trust Center Settings” button on the lower right in the pane.  Within the next pane, select “Macro Settings”.  There are two of the 4 radio button settings which will enable you to get the macros going – “Disable all Macros with notification” is recommended.  Selecting this will cause the warning message to be displayed – and enable you to enable the content.  Selecting the last option (“Enable all macros”) will also work, but is not recommended.  You can enable this whilst working with scoring workbooks (it will save you having to enable macros on each file every time you open one), but there is a better way.

If you select the “Trusted Locations” button, you can add the folders in which you are keeping or will keep the scoring workbooks.  This will enable macros from all files opened from any location you add – making life much easier.




Suggestions, Problem Reports etc

This system has not been commercially developed for profit, and as such, there are no warranties provided – and no helpdesk.

Suggestions for improvements, reports of problems and requests for help can be directed via email to dressage@pobox.com 
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